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INTRODUCTION 
 

About this Manual 
The Client Portal User Manual provides detailed information pertaining to usage of Order Entry 
and Results Retrieval modules. Using strict version control, the Client Portal User Manual is 
maintained by the Information Technology (IT) Department. The Client Portal User Manual is 
updated in the following circumstances: 
 

1. Whenever there is a software version update.  
 

2. Whenever modifications are made to the Client Portal that affect the functionality of the 
software as documented in this User Manual.  

 
 

General Information  
The Client Portal is an application in which authorized users may place orders and retrieve 
reports.  User roles are assigned to each individual under an account by the Client Support 
Team. 
 
The Laboratory Reports provided in the Client Portal are in pdf format and derived from our 
LIMS system for Clinical and Forensic type work.  The application will allow the user to view 
and download reports. 
 
A feature to assign an email notification alert is available.  This allows a user the flexibility in 
assigning a routine schedule to receive a notification that a report(s) is available.    
 
A Test Catalog tool is available to all users who have access to the Client Portal. 
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Client Support Information 
 
 
Client Support Hours: Monday through Friday 8:00am - 8:30pm ET  
 
Clinical & Research clients: 1-866-522-2206 / CSTIQ@nmslabs.com 
Forensic clients: 1-866-522-2216 / Forensics@nmslabs.com 
Expert Service clients: 1-844-276-0768 / expertservices@nmslabs.com 
Billing inquiries: 1-800-522-6671 / BillingTIQ@nmslabs.com 
Criminalistics & DNA clients: 1-844-276-1182 / Crimelab@nmslabs.com 
 
 
Mailing addresses: 
 
NMS Labs 
200 Welsh Rd 
Horsham, PA 19044 
 
NMS Labs Crime Lab 
2300 Stratford Avenue 
Willow Grove, PA 19090 

mailto:CSTIQ@nmslabs.com
mailto:Forensics@nmslabs.com
mailto:expertservices@nmslabs.com
mailto:BillingTIQ@nmslabs.com
mailto:Crimelab@nmslabs.com
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Client Portal Workflow 
The Client Portal application is comprised of modules that allow users to order and receive 
results.  Below is a general example of the Life Cycle within the Client Portal. 
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Client Portal Identifiers, Codes and Terms 
 
Client Portal Identifiers Definition 

Accession Unique number used to identify the Client Portal Case. 
Format: NMSCP-NNNN; Example: NMSCP2815 

• N = 4-Digit Unique Number  
 
The unique number will increase after it reaches 9999 
 

Case ID/Incident Number The Client’s unique number used to identify a Laboratory Case. 
 

Requisition Type / Work 
ID 

The type of work submitted. 
 

• Police 
• Postmortem 
• Other (Clinical) 

 
Sample The Specimen being submitted to NMS Labs. 
Requisition A report with the information entered including the Patient 

Demographics, Case Information and Testing requested.   
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CLIENT PORTAL MAINTENANCE 
 

Schedule 
 

Description Day Time (EDT) Duration 
(approx.) 

Server Backup (SQL) Sunday 3:00am 15 minutes 
Server Backup (SQL) Nightly 2:00am 10 minutes 
Server Backup (IIS) Sunday 2:00am 10 minutes 
Server Backup (IIS) Nightly 1:00am 10 minutes 
SQL Backup Nightly 8:00pm 5 minutes 
Index Rebuild Sunday 12:00am 5 minutes 
Statistics Sunday 1:00am 5 minutes 
DBCC Check Sunday 3:00am 5 minutes 

 
 
It is recommended to exit the system during the maintenance window. 
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USER LOGIN 
 

Getting Started 
 
Accessing the Client Portal 
An email invite will be generated by the NMS Client Support department.  Upon receipt of the 
email, click the link for the creation of a password.  Log onto to the Client Portal using your 
email address and secure Password.  
 
Web Browser 
Do not use the web browser's back and forward buttons to navigate between application 
windows. Instead, use the tabs and the links provided within the application.  
 
Client Portal Application Location 
The Client Portal link is https://portal.nmslabs.com 
The Client Portal is also located on the NMS website. 
 
Session Lock-Out 
Three (3) subsequent incorrect attempts to logon using your User ID and Password will lock 
your user session. Contact the Help Desk to have your session unlocked. 
 
Session Time-Out 
After 30 minutes of inactivity, the Client Portal will log-out your session. You will be returned to 
the Main Logon Window.  
 
Label Printer 

• NMS recommends the Dymo® LabelWriter® 450 model label printer and 1” x 2 1/8” size 
labels. 
 

• Install the label printer using the CD provided with the printer or by following the URL: 
http://www.dymo.com/en-US/online-support/dymo-user-guides. Under the Latest Software & 
Drivers for all Label Writers and Label Manager section, click the Download for the 
DYMO Connect option for Desktop Windows.  
 
Note: The Dymo Connect Web Service (which runs after the installation is complete) 
directly interacts with the Client Portal and requires that all users be added and have the 

https://portal.nmslabs.com/
http://www.dymo.com/en-US/online-support/dymo-user-guides
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full control to the private key of the DYMO Root CA SSL Certificate. This can be done 
by performing the following: 
 

o Open the Management Console (mmc.exe) AS an Administrator 
o Go to File > Add/Remove Snap-In. 
o Add Certificates and select Computer Account and Local Computer when 

prompted. 
o Under Certificates > Personal > Certificates, locate the certificate issued by 

‘DYMO Root CA (for localhost)’. 
o Right click on the cert and proceed to All Tasks > Manage Private Keys. 
o Add a new user or group of users to the Security. This should be the users or 

groups that will use the Dymo Label Printer to print labels from the NMS Client 
Portal.  

o After adding, confirm that they have Full Control and Read permissions. 
 

• Browsers that support the Dymo® label printer: 
o On Windows: Internet Explorer 6+, Firefox 2+, Chrome 4, Opera 10, Safari 
o On Mac: Safari 4+, Firefox, Chrome, Opera.  
o If using Firefox 2+ please ensure that the certificate is present: 

https://localhost:41951/DYMO/DLS/Printing/Check  
To permanently save the cert, please turn off "Never remember history" in 
Options > Privacy & Security tab.   
Important: When accepting the cert, make sure the "Permanently store this 
exception" checkbox is checked. 
 

• Troubleshooting Label Printer issues: 
o Start with the following link: portal.nmslabs.com/home/labelprinterhelp. After 

running, this should display some information on the screen. Please submit a 
screen capture to NMS for further assistance. 

o Check the Dymo Web Service in the Task tray. Right click and select 
Diagnose. If you receive an SSL connection error, please ensure you have 
completed the steps above regarding the SSL certificate. 

 
 
 

https://localhost:41951/DYMO/DLS/Printing/Check
https://portal.nmslabs.com/home/labelprinterhelp
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Security 
It is always required to log out of the Client Portal application when you leave your workstation 
unattended. Any actions performed in the Client Portal under your logged-in user will be 
recorded as being executed by you, even if it was not. To protect yourself, remember to always 
log out of the Client Portal before moving away from your workstation. 
 
Exiting the Client Portal 
To exit and close the Client Portal application, it is advised to use the Logout link located in the 
upper right section of the screen. This will return you to the Main Logon screen. You can then 
close the application by clicking on the X in the upper right section of the screen. 
 
 
 

Login Steps 
 

 
 
The Client Portal Logon Window requires that you enter your User ID and secure Password  
 



   
Client Portal  
Software Version: 1.7.0 

 

This documentation is considered PROPRIETARY and is made available for business operations and review by employees of 
NMS Labs and regulatory agencies. Distribution to third parties without prior permission is prohibited. 
    
10 - 52 

NOTE:  The NMS Client Support team will activate your user and send an email link in which 
you may create your password.   
 

1. Enter your email address within the field provided 

 
 

2. Enter your Password within the field provided 

 
 
 
 

Forgot Password 
 

1. If you forget your password, click the Forgot your password link on the Log in page. 
2. An email will generate for the creation of a new password. 
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Change Password 
 

1. If a user wants to change the password, click on My Account.  My Account located in 
the upper right corner of your screen. 
 

 
 

2. Click Update Settings. 
 

 
 

3. Enter new password information. 
 

Email Notification 
 
An email notification for when reports are available is configurable per each user’s setup. 
 

1. Click My Account located in the upper right corner of your screen.   
 

 
 

2. Click Update Settings. 
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3. Select the day(s) that you would like to receive email notifcations. 
Note: The email delivery is Eastern Standard Time. 

 
 

4. Select the time(s) that you would like to receive email notifications. 

 
 

5. Click Add Time. 
 

 
 

6. Click Save Settings. 
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E-Signature 
 
The following is information for adding your electronic signature for upload onto the final report. 
 

1. Click My Account located in the upper right corner of your screen.   
 

 
 
 

2. Click Update Electronic Singature 
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3. Enter the credentials to appear below the signature and click Save Information 

 
 

4. If you have an image of the electronic signature you may click Browse and Upload 
Signature 
Note: The image must be Height 200 x Width 600 
Hint: When you right click on your image there is an option to adjust the pixel size 

 
 

 
 

5. The Create a new Electronic Signature option allows the user to use the mouse for 
signing.  Click Save Signature. 
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ORDER ENTRY 
 
Authorized users will have access to an Orders tab upon logging into Client Portal.  
 
The Order Entry access allows users to place electronic orders prior to sending the samples to 
NMS Labs.   
 

Create an Order  
 

1. From the Orders Screen Click the New Case button. 

  
 

2. A new tab opens.  Select the account number that you wish to place an order for and 
click the Select Button. 
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Case Information 
 

 
1. The Case Info window opens with a Requisition Type option. 

• The Requisition Type will default to the type of work that your account would 
typically send for testing. 

• If a different type of service is required, i.e., Postmortem vs. Police then click 
the Drop Down option to change the selection. 

 
 
 

2. The Demographic section contains the Patient identifying items related to the case. 
• Case ID – The client’s identification number for this submission. 
• First Name – The First Name of the Decedent, Suspect or Patient. 
• Middle Initial – The Middle Initial of the Decedent, Suspect or Patient. 
• Last Name – The Last Name of the Decedent, Suspect or Patient. (Required) 

o If the Last Name is unknown enter ‘NP’ for ‘Not Provided’ 
• Labeled As – A concatenation of the Last Name, First Name and Middle initial.  

The field is truncated to meet the label field length requirements. 
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3. The Requisition section contains questions specific to the type of requisition 
i.e., Postmortem vs. Police.  After entering the Requisition questions click Next. 
 
Postmortem requisition questions: 
Note: Please enter the Autopsy ID only if it differs from the Case ID. 
 

 
 

4. The page icon indicates the values are included on the final report. 
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Police requisition questions: 
 

 
5. The page icon indicates the values are included on the final report. 

6. The asterisk icon indicates the value is required. 
 
 
 

Add Samples  
 

 
1. The Add Samples window opens. 

• Select the Matrix Type. (Required) 
• Select the Matrix Source if it is available. 
• Enter the Collection Date/Time if it is available. 
• Click <Add Sample> 

 
Important! Please ensure the collection date/time entered is correct for each sample 
submitted. 
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2. Click the button to duplicate samples with the same Matrix, Matrix Source and 
Collection Time. 
 

 
 
 
 

3. Click the  button to delete a sample. 

 
 

4. Click the button to edit a sample. 
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Add Testing 
 
 

1. Add Favorite Test – This is a quick selection of a frequently ordered test. 
Note: If you would like additional tests added to this quick link please contact the  
NMS Client Support Department. 

 
 

2. Search Test Catalog – This option allows a search by test code, test description and 
synonym. 
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3. For additional information related to the test, click the i (information) button. 

 
4. To begin the process of adding a Test select the + button 
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5. To Add a test to a specific sample click ‘Add’ next to the Sample. 

 
6. If you do not wish to add the test directly to a sample then click the ‘Add to any sample’ 

option. 
• Note this option will allow NMS to determine which sample to run the testing on. 

 

 
7. The tests added will appear under the Test(s) section.  When you have completed 

adding the tests for this sample click the Add to Cart button. 
Note: To remove the test click the x located to the right of the Test Description. 
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Multiple Cases 
 
You may have many cases on an order, or you may have one case per order. 
 

1. After clicking Add to Cart from the Add Testing page, the Orders window will open. 
• The Cart reflects how many cases are on the order. 

 
 

 
2. Click the New Case button to add another case to the order. 

• The New Case button will begin the workflow for adding the second case’s 
Patient Demographic, Samples, and test codes. 

 

 
3. When all Case and Sample information have been entered click the Review Button. 
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Order Review 
 
 

1 After clicking Review from the Orders page, the Order Review window will open. 
• The Review screen is the last opportunity to make modifications to the order. 

 
2 To Edit Information on the Case, click the Edit Case button. 

 
3 The Submit for Testing button will send the order electronically to NMS Labs. 

• The Requisition will auto-generate. 

 
 
Important: If modifications are required after Submit for button is clicked please 
contact the Client Services department. 
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4 The Requisition will auto-generate and labels will auto-print if configured as so. 

• An option to reprint the Requisition, Labels or to view the Order History is 
available upon completion. 

 

 
• A second option to reprint the Requisition, Labels or to view the Order History is 

available in the Order Details. 
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LABELS 
 
 

Setup Labels  
 

1. Click the My Account option located on the upper right side of the screen. 

  
. 

2. On the Manage Account screen, click Update Settings 
 
 

 
 

3. Select the Label Auto Print option 
• None – The labels are available for manual printing 
• Order Complete – The label will print upon submission of an order. 
• Sample Complete – The lables will auto-print with the completion of each sample 

entry. 
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4. Enter the number of labels to print in the Label Print Count field. 

 
 

5. Select the Default Printer 
• NMS recommends use of the Dymo® LabelWriter® 450 model label printer and 

1” x 2 1/8” size labels. 
 

 
 

• Browsers that support the Dymo® label printer: 
 On Windows: Internet Explorer 6+, Firefox 2+, Chrome 4, Opera 

10, Safari 
 On Mac: Safari 4+, Firefox, Chrome, Opera.  
 If using Firefox 2+ please ensure that the certificate is present: 
https://localhost:41951/DYMO/DLS/Printing/Check  

 
 
 
 
 

https://localhost:41951/DYMO/DLS/Printing/Check
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• Install the label printer: 
 

 Follow the URL: 
http://www.dymo.com/en-US/online-support/dymo-user-guides 
 
o Click the Download option under the Latest Software & Drivers. 

 
 

• After the installation is complete select the DYMO LabelWriter 450 from the 
Default Printer field. 
Note: Recommend installing the DYMO version 8.7.3 or later. 
The newest version of the software can be found here: 
http://download.dymo.com/dymo/Software/Win/DLS8Setup.8.7.3.exe 

 
 

 
 
 

http://www.dymo.com/en-US/online-support/dymo-user-guides
http://download.dymo.com/dymo/Software/Win/DLS8Setup.8.7.3.exe
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6. Click Save Settings. 
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WORKFLOW – E-SIGNATURE 
 
Authorized users will have access to a Workflow tab upon logging into Client Portal.  
Note: This is a special tox workflow setup for specific accounts.  Please reach out to your 
Sales Manager or Client Support representative for additional information. 
 
 

Case Assignment  
 

1. Click on the Workflow tab. 

  
 
 

2. Click the Report Details icon.  
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3. Select a User from the drop downlist and click Assign to User. 
Note: There is an option to Download Report if you wish to review the report prior to 
assignment. 
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Apply E-Signature  
 

1. Click on My Work tab. 
2. Click the Report Details icon. 

 

 
 

3. Click the Download Report button to review the report. 
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4. Click the Accept & Sign button. 

 
 

5. Enter your password and click Sign Document 

 
 

Email Tox  
 

1. Click the Questions?Email a Tox button should you have questions on a case 
Note: If you click on this link, please ensure you have the proper default selected for 
MAILTO email. See the next section Default Email Setup. 

 

 
 
 



   
Client Portal  
Software Version: 1.7.0 

 

This documentation is considered PROPRIETARY and is made available for business operations and review by employees of 
NMS Labs and regulatory agencies. Distribution to third parties without prior permission is prohibited. 
    
36 - 52 

Default Email Setup 
 
Internet Explorer / Windows 

1. Click Tools>Internet Options. 
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2. Click the Programs tab. 
3. Click Set Programs. 
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4. Click Set your default programs. 

 
5. Select your email default app and click Set this program as Default. 
6. Click OK. 
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Firefox 
1. Open the menu and select Options. 

 
2. Scroll down until you find the section labeled Applications. 
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3. Change the mailto action to your preferred email client. 

 
 

Chrome 
1. The first time you click on a mailto link chrome will prompt you with which application to 

use 

 
2. To change your setting on windows, go to the Start Menu. 
3. Search for and open Control Panel. 
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4. Search for Default Programs. 

 
5. Click associate a file type or protocol with a program. 

 
6. A new window will open up, Click on your email app, and select a new default app 
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Safari / Mac OSX 
1. Instructions provided by apple for changing the default mail client are available here: 

https://support.apple.com/en-us/HT201607  

 
 

 
 
 

https://support.apple.com/en-us/HT201607


   
Client Portal  
Software Version: 1.7.0 

 

This documentation is considered PROPRIETARY and is made available for business operations and review by employees of 
NMS Labs and regulatory agencies. Distribution to third parties without prior permission is prohibited. 
    
43 - 52 

 

REPORTS 
 
Authorized users will have access to a Reports tab upon logging into Client Portal.  Depending 
on the level of access the user may have access to Results or Litigation. 
 

Report Options 
 

1. A user can control if all reports are marked as read or unread once downloaded.  
 

2. If the user wants reports to remain visible in the results tab, even after a report is 
downloaded, go to My Account.  My Account located in the upper right corner of your 
screen. 
 

 
 

3. Click Update Settings. 
 

 
4. Go to Report Options.  Check the box if you want reports marked as read upon 

download (default setting).  Uncheck the box if you want reports to be marked unread 
even after download. 

 
5. Important: When downloading a report, the system will automatically mark the 

report as ‘Read’ unless the setting is changed.   A report can be manually marked 
as read by a user. 
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6. If a report is marked read, it can still be retrieved.  From the Results tab, click Show 

Read Reports to view the report after opening the report.  
 

7. When searching for a report, check the Show Read Reports box so that all documents 
are evaluated.   
 

8. Final reported results and Litigation Packets 
 

9.  are supplied in an Adobe (.pdf) format.   
 

View a Report  
 

1. Click on the download symbol 
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2. Click Open 

 

`````  
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Print Multiple Reports  
 

1. Use the keyboard Ctrl Click or Shift Click to select the reports for printing 
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2. Click the drop-down arrow located on the bottom left of the screen and select 
Download to Zip. 

 
3. Click the Open option. 
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4. Click Extract all 

 
 
 
 

5. Click Extract. 
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6. Shift Click or Ctrl. Click to select the files for printing 

 

 
 

7. Right click and select Print 

 
Change Report Status to Unread 
 
When opening or downloading a report the status will automatically update to Read unless the 
appropriate report option is unchecked in Settings. 
To update the status to Unread, follow the steps below: 
 
 

1. Click Show Read Reports. 

 
 

2. Select the report by clicking on the case ID or select multiple reports by using the 
keyboard Ctrl Click or Shift Click to select the reports for printing. 
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3. Click the drop-down list and select Mark as Unread 
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TEST CATALOG 
 
Authorized users will have access to the Test Catalog tab upon logging into Client Portal.  
 
The Test Catalog access allows users to view test specific information 
 

Searching the Test Catalog 
 

1. The Test Catalog may be searched by the following: 
• Test Code (i.e., 1300B) 
• Test Description (i.e., cocaine) 
• Matrix (i.e., Blood) 
• Synonym (i.e., Crack) 
• Method: (i.e., High Performance Liquid Chromatography) 
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2. Click the i button to view information pertaining to the test code. 

 
 

3. The information is organized in three tabs: 
• Overview: Test Code, Test Name, Test Includes, Synonym(s) Method(s) and 

Purpose 
• Specimen: Requested Volume, Minimum Volume, Transport Temperature, 

Specimen Container, Special Handling, Light Protection Required, Rejection 
Criteria, Stability 

• Other: Turnaround Time, Suggested CPT Code(s) 
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